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1 Overview 

 

This application note describes in detail the steps required to make a noise figure measurement using a 

spectrum analyzer and the “Y Factor” technique. Background equations are presented for each step of the 

calculation. In addition, guidelines are provided to ensure a repeatable measurement. Measurement 

uncertainty is then reviewed, including contributions due to the noise source, analyzer, and the DUT itself. 

Finally, a software utility is presented that automates the noise figure calculation using four measurements 

from a spectrum analyzer. The utility checks the measurement guidelines and highlights potential problem 

areas. It then calculates the noise figure and gain of the DUT along with the measurement uncertainty. 
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2 Introduction 

This application note describes in detail the steps required to make a noise figure measurement using a 

spectrum analyzer and the “Y Factor” technique.  Background equations are presented for each step of the 

calculation.  In addition, guidelines are provided to ensure a repeatable measurement.  Measurement 

uncertainty is then reviewed, including contributions due to the noise source, analyzer, and the DUT itself. 

Finally, a software utility is presented that automates the noise figure calculation using four measurements 

from a spectrum analyzer.  The utility checks the measurement guidelines and highlights potential problem 

areas.  It then calculates the noise figure and gain of the DUT along with the measurement uncertainty. 

2.1 Definition of Noise Figure 

The noise figure of a device provides a quantifiable measure of the noise that a device under test (DUT) adds 

to a signal as that signal passes through it.  Stated another way, noise figure quantifies how much a DUT 

degrades the signal to noise ratio of a signal.  It is a well defined, easy to measure, and common figure of 

merit found on specification sheets for different types of RF and microwave devices. 

Consider a device with an input consisting of signal Sin plus noise Nin and gain G. The signal to noise ratio 

(SNR) at the input is 𝑆𝑖𝑛 𝑁𝑖𝑛⁄ .  Since 𝑆𝑜𝑢𝑡 = 𝑆𝑖𝑛𝐺,  the SNR at the output is 𝑆𝑖𝑛𝐺 𝑁𝑜𝑢𝑡⁄  (see Figure 1). 

 

Figure 1: Graphical Representation of Signal to Noise Ratios at the input and output of a DUT. 

The linear ratio of these quantities is the noise factor F. Converting noise factor to the log domain gives the 

more commonly used noise figure 𝐹𝑑𝐵. 

Noise Factor: 𝐹 =
𝑁𝑜𝑢𝑡

𝑁𝑖𝑛𝐺
 

Noise Figure: 𝐹𝑑𝐵 = 10 𝑙𝑜𝑔 (
𝑁𝑜𝑢𝑡

𝑁𝑖𝑛𝐺
) 

2.2 Overview 

The measurement described in this application note uses the Y factor technique to measure noise figure with 

a spectrum analyzer. This technique utilizes a characterized broadband noise source that contains two 

temperature states: A high temperature state, 𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝑁  with a higher output of noise power, and a low 

temperature state, 𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹  with reduced noise output. The noise source is applied to the DUT input and the 

noise power at the output of the DUT is measured for each of the two input noise states.   

The noise figure and gain of the DUT are calculated from these measurements. 
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2.3 Required Equipment 

Fehler! Verweisquelle konnte nicht gefunden werden. shows a common setup for making a noise figure 

measurement. The required equipment is a spectrum analyzer and a noise source. The spectrum analyzer 

often contains a built in pre-amplifier. An integrated 28V DC port is a convenient addition to the spectrum 

analyzer and facilitates automation of the measurement process. This DC supply is used to turn the noise 

source on and off, switching it between its hot and cold states. 

 

Figure 2: Common Setup to Measure Noise Figure. 
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3 Background Theory and Equations 

To make a manual noise figure measurement using a spectrum analyzer there is a need to convert between 

different quantities such as noise figures, noise factors, noise temperatures, linear gain, log gain, linear 

power and log power. The equations needed for these conversions are listed in this section for reference. 

As a convention, log parameters will be denoted with the suffix “dB” in the variable name and also in the units 

of the value. For an example, see  

Starting with a linear power, P, in units of watts, the first conversion required is to express the linear power as 

a log power. All log powers will be in units of dBm, which is a ratio of the linear power to 1 mW. 

𝑃𝑑𝐵𝑚 = 10 𝑙𝑜𝑔 (
𝑃

0.001
) (1) 

The inverse relationship converts a log power “𝑃𝑑𝐵𝑚” to a linear power with units of watts. 

𝑃 = (0.001) ⋅ 10(
𝑃𝑑𝐵𝑚

10⁄ ) (2) 

In a similar way, linear noise factors “F” are converted to log noise figures: 

𝐹𝑑𝐵 = 10 𝑙𝑜𝑔(𝐹) (3) 

And the inverse equation is given as 

𝐹 = 10(
𝐹𝑑𝐵

10⁄ ) (4) 

Gain conversion utilizes this equation for linear gain, G, to log gain: 

𝐺𝑑𝐵 = 10 𝑙𝑜𝑔(𝐺) (5) 

And the inverse equation is given as 

𝐺 = 10(
𝐺𝑑𝐵

10⁄ ) (6) 

Noise Figure (log) is related to Noise Temperature by equation (7).   

𝑇𝐷𝑈𝑇 = 𝑇0 (10(
𝐹𝑑𝐵

10⁄ ) − 1) (7) 

Where 𝑇𝑜 is the ambient temperature of the DUT. Noise Temperatures use the Kelvin scale. 

The inverse equation follows as 

𝐹𝑑𝐵 = 10 𝑙𝑜𝑔 (
𝑇𝐷𝑈𝑇

𝑇0

+ 1) (8) 

Noise sources are commonly specified by their excess noise ratio, or ENR value, which is expressed in dB. 

The relationship between noise temperature and ENR is shown in equation (9).  The calibrated ENR values 

supplied by the noise source manufacturer are generally referenced to 𝑇𝑜 = 290𝐾. 

𝐸𝑁𝑅𝑑𝐵 = 10 𝑙𝑜𝑔 (
𝑇𝑠𝑜𝑢𝑟𝑐𝑒

𝑂𝑁 − 𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹

𝑇0

) (9) 

The conversion from ENR to an “on” temperature is then given by: 

𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝑁 = 𝑇𝑜 (10[

𝐸𝑁𝑅
10

]) + 𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹 (10) 

The remaining equations in this section are related to the Y factor method.  The Y factor method uses the 

measured noise power at the DUT output with a room temperature noise source (noise source off) at the 

input, and with a high temperature noise source (noise source biased with 28V) at the input. 
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Figure 3: Diagram showing the Y factor noise figure variables. 

These two measurements establish a line (see Figure 4) from which the DUT gain, GDUT, can be 

determined. The Y-intercept indicates the noise added by the DUT, NDUT. Figure 4 also includes variables 

for the bandwidth (in Hz) of the noise measurement, B, and Boltzmann’s constant, k (1.38 x 10-23 Joules/˚K). 

 

 

The Y factor term can be found by taking the ratio of the measured (linear) noise power at the DUT output 

when the noise source is on and off. 

𝑌 =
𝑁𝑜𝑛

𝑁𝑜𝑓𝑓

(11) 

The Y factor can be used to calculate the noise temperature of the DUT with the following equation: 

𝑇 =
𝑇𝑠𝑜𝑢𝑟𝑐𝑒

𝑂𝑁 − 𝑌 ⋅ 𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹

𝑌 − 1
(12) 

Because the spectrum analyzer itself also contributes to the overall noise result (due to its own noise figure), 

it is usually necessary to characterize the spectrum analyzer’s noise figure (or linear noise factor), and then 
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subtract it from the overall measurement by using the cascaded noise factor equation. This is often called 

second stage correction or calibration. In cases where the DUT has high gain and high noise figure and the 

spectrum analyzer has low noise figure the second stage error is negligible and the calibration step can be 

omitted. In most cases, however, second stage correction is recommended. Equation (13) is the linear form 

of the cascaded noise figure equation. 

𝐹𝐷𝑈𝑇&𝑆𝐴 = 𝐹𝐷𝑈𝑇 +
𝐹𝑆𝐴 − 1

𝐺𝐷𝑈𝑇

(13) 

Both the noise figure of the spectrum analyzer and the noise figure of the cascade can be directly measured. 

The linear equation for the gain of the DUT is: 

𝐺𝐷𝑈𝑇 =
𝑁𝑜𝑛

𝐷𝑈𝑇&𝑆𝐴 − 𝑁𝑜𝑓𝑓
𝐷𝑈𝑇&𝑆𝐴

𝑁𝑜𝑛
𝑆𝐴 − 𝑁𝑜𝑓𝑓

𝑆𝐴
(14) 

Equation (15) is used to calculate the noise temperature of the DUT from the gain of the DUT and the noise 

temperature of the second stage (which is the spectrum analyzer). 

𝑇𝐷𝑈𝑇 = 𝑇𝐷𝑈𝑇&𝑆𝐴 −
𝑇𝑆𝐴

𝐺𝐷𝑈𝑇

(15) 

Equation (16) shows a simplified form of the noise figure equation which results from combining equations 

(8), (9), and (12). 

𝐹𝑑𝐵 = 𝐸𝑁𝑅𝑑𝐵 − 10 𝑙𝑜𝑔(𝑌 − 1) (16) 

Where Y is the measured Y factor as a linear ratio. 

  



 

Rohde & Schwarz | Application Note The Y Factor Technique for Noise Figure Measurements  9 

 

     

 

4 Detailed Measurement Steps 

Noise Figure measurements with a spectrum analyzer consist of three main tasks: Calibration of the setup, 

measurement of the DUT, and calculation of the Noise Figure and Gain of the DUT. 

The steps are listed below, along with the results obtained by making an example measurement on a small 

signal gain block at 1 GHz.   

Calibration 

 

Measurement 

 

(a) (b) 

Figure 5: Connection diagram for (a) the calibration step, and (b) the measurement of the DUT's noise figure. 

There are three primary steps for making the measurement 

1. Calibration where the noise figure of the test equipment is measured 

2. Measurement of the DUT cascaded with the test equipment. 

3. Calculate of the DUT’s parameters by using the cascaded noise figure equation. 

Each of these are covered in more detail in the next section. 

4.1 Calibration Step 

1. Connect the equipment as shown in Figure 5a.  (No DUT) 

─ Connect the output of the noise source to the RF input of the spectrum analyzer. 

─ Connect the noise source control of the spectrum analyzer to the noise source. 

2. Enter the following settings on the spectrum analyzer:  

─ Set the spectrum analyzer to the desired test frequency   

(For example:  990 to 1010 MHz) 

─ Set the RBW to be less than the BW of the DUT   

(For example:  1 MHz) 

─ Enable the preamplifier in the spectrum analyzer. 

─ Set the RF attenuator to 0 dB. 

─ Set the Reference level to a fairly low value 

(For example:  -80 dBm.) 

─ Set the Log range to a fairly low value 

(For example:  30 dB.) 
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─ Select the RMS detector, 

─ Select a slower sweep time to RMS average the results.   

(For example:  1 second.) 

 

3. Use equation (10) to find the temperature of the noise source when it is on. Generally, the ENR value of 

the noise source is printed directly on the source in a table. Assume the room temp T0= 290K, and the 

off state temperature is also 290K. As an example, the noise source used during this test has an ENR 

value of 14.66 dB at 1 GHz. 

𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹 = 290𝐾 

𝑇𝑠𝑜𝑢𝑟𝑐𝑒
𝑂𝑁 =  𝑇0 (1 + 10[

14.66
10

]) = 8770.0𝐾 

4. Turn the noise source off and measure the noise power of the trace on the spectrum analyzer using a 

marker. Convert to linear noise power using equation (2). Measurement on a Rohde & Schwarz 

spectrum analyzer yielded -104.5 dBm of noise power. Note that 1 femtowatt (fW) = 1 x 10-15 W. 

𝑁𝑜𝑓𝑓 _ 𝑑𝐵
𝑆𝐴 = −104.5𝑑𝐵𝑚 

𝑁𝑜𝑓𝑓
𝑆𝐴 = 35.48𝑓𝑊 

5. Turn the noise source on, measure the noise power of the trace using a marker. Convert to linear noise 

power using equation (2). An example measurement on a Rohde & Schwarz spectrum analyzer had a 

noise power reading of -97.6 dBm during this step. 

𝑁𝑜𝑛 _ 𝑑𝐵
𝑆𝐴 = −97.6𝑑𝐵𝑚 

𝑁𝑜𝑛
𝑆𝐴 = 173.8𝑓𝑊 

6. Calculate the linear Y factor using equation (11).  Notice that the units and the impact of the selected 

resolution bandwidth cancel out of the Y factor term.  This is an advantage of the Y factor technique. 

𝑌𝑆𝐴 =
𝑁𝑜𝑛

𝑆𝐴

𝑁𝑜𝑓𝑓
𝑆𝐴  

𝑌𝑆𝐴 =
173.8

35.48
 

𝑌𝑆𝐴 = 4.898 

7. Then use equation (12) to solve for the noise temperature of the spectrum analyzer 

𝑇𝑆𝐴 =
𝑇𝑠𝑜𝑢𝑟𝑐𝑒

𝑂𝑁 − 𝑌𝑆𝐴 ⋅ 290

𝑌𝑆𝐴 − 1
 

𝑇𝑆𝐴 =
8770.0 − 4.898 ⋅ 290

4.898 − 1
 

𝑇𝑆𝐴 = 1885.6𝐾 

8. Finally, convert the noise temperature of the spectrum analyzer into a noise figure by using equation (8). 

𝑁𝐹𝑑𝐵
𝑆𝐴 = 10 𝑙𝑜𝑔 (

1885.6

290
+ 1) 

𝑁𝐹𝑑𝐵
𝑆𝐴 = 8.75𝑑𝐵 

9. Or use the ENR value and the Y factor along with equation (16) to calculate the NF directly 

𝑁𝐹𝑑𝐵
𝑆𝐴 = 14.66 − 10 𝑙𝑜𝑔(4.898 − 1) 

𝑁𝐹𝑑𝐵
𝑆𝐴 = 8.75𝑑𝐵 
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4.2 Measurement Step 

In this step the cascaded noise figure of the device under test and the spectrum analyzer are measured. 

Start by connecting the DUT between the noise source and the spectrum analyzer as shown in Figure 5b. 

1. Turn the noise source off and measure the noise power of the trace. In this example, the small signal 

amplifier connected to the Rohde & Schwarz spectrum analyzer had an output power level of -93.63 

dBm. 

𝑁𝑜𝑓𝑓 _ 𝑑𝐵
𝐷𝑈𝑇&𝑆𝐴 = −93.6𝑑𝐵𝑚 

 

𝑁𝑜𝑓𝑓
𝐷𝑈𝑇&𝑆𝐴 = 436.5𝑓𝑊 

2. Turn the noise source on and measure the noise power of the trace.  The DUT plus spectrum analyzer 

had a level of -82.58 dBm in this step. 

𝑁𝑜𝑛 _ 𝑑𝐵
𝐷𝑈𝑇&𝑆𝐴 = −82.5𝑑𝐵𝑚 

 

𝑁𝑜𝑛
𝐷𝑈𝑇&𝑆𝐴 = 5623𝑓𝑊 

3. Use equation (11) to calculate the linear Y factor of the cascade.   

𝑌𝐷𝑈𝑇&𝑆𝐴 =
5623

436.5
 

𝑌𝐷𝑈𝑇&𝑆𝐴 = 12.88 

4. Then use equation (12) to solve for the noise temperature of the cascade. 

𝑇𝐷𝑈𝑇&𝑆𝐴 =
𝑇𝑠𝑜𝑢𝑟𝑐𝑒

𝑂𝑁 − 𝑌𝐷𝑈𝑇&𝑆𝐴 ⋅ 290

𝑌𝐷𝑈𝑇&𝑆𝐴 − 1
 

𝑇𝐷𝑈𝑇&𝑆𝐴 =
8770.0 − 12.88 ⋅ 290

12.88 − 1
 

𝑇𝐷𝑈𝑇&𝑆𝐴 = 423.7𝐾 

5. Convert the cascaded noise temperature into a noise figure with equation (8). 

𝑁𝐹𝑑𝐵 = 10 𝑙𝑜𝑔 (
𝑇𝐷𝑈𝑇&𝑆𝐴

𝑇0

+ 1) 

𝑁𝐹𝑑𝐵 = 10 𝑙𝑜𝑔 (
423.7

290
+ 1) 

𝑁𝐹𝑑𝐵 = 3.91𝑑𝐵 

6. Or use equation (16). 

𝑁𝐹𝑑𝐵 = 14.66 − 10 𝑙𝑜𝑔(12.88 − 1) 

𝑁𝐹𝑑𝐵 = 3.91𝑑𝐵 

 

4.3 Calculation Step 

In the final step calculate the gain and the noise figure of the DUT by applying the cascaded noise figure 

equations. 

1. Use equation (14) to calculate the linear gain of the DUT.  This is another equation where the units and 

the impact of the selected resolution bandwidth cancel. 

𝐺𝑎𝑖𝑛𝐷𝑈𝑇 =
5623 − 436.5

173.8 − 35.48
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𝐺𝑎𝑖𝑛𝐷𝑈𝑇 = 37.51 

2. Use equation (5) to convert to a log gain 

𝐺𝑎𝑖𝑛𝐷𝑈𝑇 = 10 𝑙𝑜𝑔( 37.51) 

𝐺𝑎𝑖𝑛𝐷𝑈𝑇 = 15.74𝑑𝐵 

3. Use the equation (15) to calculate the noise temperature of the DU 

𝑇𝐷𝑈𝑇 = 𝑇𝐷𝑈𝑇&𝑆𝐴 −
𝑇𝑆𝐴

𝐺𝑎𝑖𝑛𝐷𝑈𝑇

 

𝑇𝐷𝑈𝑇 = 423.7 −
1885.6

37.51
 

𝑇𝐷𝑈𝑇 = 373.4𝐾 

4. And finally calculate the noise figure with equation (8) 

𝑁𝐹𝑑𝐵 = 10 𝑙𝑜𝑔 (
373.4

290
+ 1) 

𝑁𝐹𝑑𝐵 = 3.59𝑑𝐵 
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5 Selecting a Spectrum Analyzer and Noise Source 

Below are three guidelines to use when selecting a noise source and a spectrum analyzer for making a noise 

figure measurement. The purpose of the guidelines is to ensure there are adequate deltas between the four 

individual measurements described in 4.1 and 4.2. This minimizes the effect of the inherent noise (non-

repeatability) of the individual measurements. Satisfying these guidelines will help ensure an accurate and 

repeatable measurement. 

1. The first guideline addresses the two measurements of the calibration step. We would like the difference 

between the noise source on and off measurements to be at least 3dB. To accomplish this we must 

choose a noise source with ENR at least 3dB greater than the noise figure of the spectrum analyzer. 

𝐸𝑁𝑅𝑑𝐵 > 𝑁𝐹𝑑𝐵
𝑆𝐴 + 3𝑑𝐵 

 The section 3 example satisfies this criterion: 

14.66𝑑𝐵 > 8.75𝑑𝐵 + 3𝑑𝐵 

14.66𝑑𝐵 > 11.75𝑑𝐵 

2. The second guideline addresses the two measurements of the measurement step. Here, we would like 

the difference between the noise source on and off measurements to be at least 5dB. To accomplish 

this we must choose a noise source with ENR at least 5dB greater than the noise figure of the DUT. 

𝐸𝑁𝑅𝑑𝐵 > 𝑁𝐹𝑑𝐵
𝐷𝑈𝑇 + 5𝑑𝐵 

 The section 3 example satisfies this guideline: 

14.66𝑑𝐵 > 3.59𝑑𝐵 + 5𝑑𝐵 

14.66𝑑𝐵 > 8.59𝑑𝐵 

3. The third guideline addresses the deltas between the measurement and calibration steps. We would like 

these differences to be at least 1dB and this is done by choosing the spectrum analyzer and preamp 

such that the noise figure of the DUT + the gain of the DUT is at least 1dB greater than the noise figure 

of the spectrum analyzer. 

𝑁𝐹𝑑𝐵
𝐷𝑈𝑇 + 𝐺𝐴𝐼𝑁𝑑𝐵

𝐷𝑈𝑇 > 𝑁𝐹𝑑𝐵
𝑆𝐴 + 1𝑑𝐵 

The section 3 example satisfies this guideline: 

3.59𝑑𝐵 + 15.74𝑑𝐵 > 8.75𝑑𝐵 + 1𝑑𝐵 

19.33𝑑𝐵 > 9.75𝑑𝐵 

 

Since all three guidelines were satisfied, the Y factor calculation should yield a repeatable result.  
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6 Automating the Measurement 

Most modern spectrum analyzers offer a personality that will make the noise figure measurement 

automatically. It will take care of the calibration and measurement steps, solve the equations, and plot the 

resulting noise figure and gain of the device under test on a frequency plot. 

In addition to this, the Noise Figure personality from Rohde & Schwarz also factors in any losses at the input 

and output of the DUT, compensating for items such as matching pads, isolators or attenuators. The impact 

of the temperature of the noise source on the ENR value is also compensated automatically. And 

measurements on frequency converting devices, such as a mixer or a receiver (RF to IF) front end, are also 

supported. 

Figure 6, Figure 7 and Figure 8 are screen shots that show a typical noise figure measurement from a Rohde 

& Schwarz FSV spectrum analyzer. 

 

 

Figure 6: Configuration window for making noise figure measurements on a R&S®FSV spectrum analyzer 
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Figure 7: Resulting plot of the noise figure and gain of the DUT. 

 

 

Figure 8: Tabular summary of the noise figure, noise temperature and gain of the DUT. 
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7 Calculating Measurement Uncertainty 

Noise figure measurement uncertainty is a key consideration when making a noise figure measurement. The 

noise figure measurement will be meaningless if the measurement uncertainty is too large. Knowing the 

uncertainty of the noise figure measurement adds value especially when comparing measurement results. 

Consider the two devices below. Which is preferred? 

DUT Noise Figure 

Supplier One 1.257 dB 

Supplier Two 1.4 dB 

 

Seemingly the amplifier with the lower noise figure (and also listed with more digits of precision) would be the 

obvious choice. But adding measurement uncertainty values to the table may change the natural conclusion. 

DUT Noise Figure NF Uncertainty 

Supplier One 1.257 dB +/- 0.5 dB 

Supplier Two 1.4 dB +/- 0.1 dB 

 

Uncertainty can be calculated in either a worst case scenario by adding up all the contributions to the overall 

uncertainty, or by using the Root of the Sum of the Squares (RSS) approach. In general, when the 

contributions are independent from each other, the RSS approach is utilized in practice as a more realistic 

bound on uncertainty. In a noise figure uncertainty calculation the contributions are independent making the 

RSS approach the appropriate selection. 

Several factors contribute to noise figure measurement uncertainty. The noise figure of the spectrum 

analyzer, uncertainty of the noise source ENR value, and gain of the DUT have significant impact. 

Impedance mismatches between noise source and DUT, DUT and spectrum analyzer, and noise source and 

spectrum analyzer (during the calibration step) also add to the overall uncertainty. 

While it is relatively easy to identify sources of measurement uncertainty, it is more difficult to distill the 

effects down to an overall uncertainty equation.  The work has been done in reference [3] by applying 

differential analysis to the cascaded noise figure equation.  The results are summarized in equation 17. 
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 (17) 

 

It is important to note that in equation 17 the four delta terms 𝛥𝐹𝐷𝑈𝑇&𝑆𝐴 _ 𝑑𝐵 , 𝛥𝐹𝑆𝐴 _ 𝑑𝐵 , 𝛥𝐺𝐷𝑈𝑇 _ 𝑑𝐵 , 𝛥𝐸𝑁𝑅𝑑𝐵 are in 

units of dB, and correspond to the four "primary contributions” of measurement uncertainty. The equations for 

these terms are covered in detail in the next section. 
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The remaining terms are combinations of the linear ratios of the measured noise factor and gain of the DUT, 

noise factor of the spectrum analyzer, and the cascaded noise factor of the spectrum analyzer and DUT.  

These values are all measured or calculated during the noise figure measurement process described in 

section 4. Note that equation (17) assumes the calibration step is performed and that the DUT is a linear 

device such as an amplifier. For frequency converting DUTs the uncertainty of the noise source ENR at the 

input and output frequencies must be taken into account and the measurement uncertainty equation is 

slightly different. The remainder of this section applies to the linear (non-frequency converting) case. 

7.1 Uncertainty in the Cascaded Noise Figure Result 

The cascaded noise figure measurement consists of two measurements to determine the cascaded Y factor.  

During these measurements two parameters dominate the error terms:   

1. The mismatch between the noise source and the input of the DUT, which creates a standing wave on 

the transmission line. 

2. The uncertainty of the spectrum analyzer's reported noise figure results. 

Mismatch calculations are well known, and the resulting error is understood to be: 

𝑚𝑖𝑠𝑚𝑎𝑡𝑐ℎ_𝑒𝑟𝑟𝑜𝑟 = ±20 𝑙𝑜𝑔( 1 ∓ 𝛤𝑠𝑜𝑢𝑟𝑐𝑒𝛤𝐷𝑈𝑇 _ 𝑖𝑛𝑝𝑢𝑡) 

The reflection coefficients of the noise source and the DUT are usually specified or easily measured. 

The noise figure uncertainty of the Spectrum Analyzer is specified by the spectrum analyzer manufacturer.   

Since the mismatch error and noise figure uncertainty are independent from each other, the root sum square 

(RSS) method is used to add them together.  The resulting error term for the measurement of the cascaded 

noise figure is show in equation (18).  This result (in units of dB) is needed to complete equation (17). 

𝛥𝐹𝐷𝑈𝑇&𝑆𝐴_𝑑𝐵 = √(20 𝑙𝑜𝑔( 1 − 𝛤𝑠𝑜𝑢𝑟𝑐𝑒𝛤𝐷𝑈𝑇𝑖𝑛𝑝𝑢𝑡
))

2

+ (𝑆𝐴𝑁𝐹 _ 𝑢𝑛𝑐𝑒𝑟𝑡𝑎𝑖𝑛𝑡𝑦  _ 𝑑𝐵)
2

(18) 

7.2 Uncertainty in the Calibration of the Spectrum Analyzer Noise 

Figure 

The next error term, uncertainty in the noise figure measurement of the spectrum analyzer during calibration, 

is similar to the first term and follows as: 

 

𝛥𝐹𝑆𝐴 _ 𝑑𝐵 = √(20 𝑙𝑜𝑔( 1 − 𝛤𝑠𝑜𝑢𝑟𝑐𝑒𝛤𝑆𝐴_𝑖𝑛𝑝𝑢𝑡))
2

+ (𝑆𝐴𝑁𝐹 _ 𝑢𝑛𝑐𝑒𝑟𝑡𝑎𝑖𝑛𝑡𝑦  _ 𝑑𝐵)
2

(19) 

This term (in units of dB) is also needed to calculate equation (17). 

7.3 Uncertainty in the Gain Measurement of the DUT 

The third term is the uncertainty in the gain measurement of the DUT.  This term is impacted by all three 

combinations of mismatch between the noise source, the DUT input and output ports, and the spectrum 

analyzer.  It is also affected by the noise figure uncertainty of the spectrum analyzer. 

𝛥𝐺𝐷𝑈𝑇 _ 𝑑𝐵 = √
(20 𝑙𝑜𝑔( 1 − 𝛤𝑠𝑜𝑢𝑟𝑐𝑒𝛤𝑆𝐴 _ 𝑖𝑛𝑝𝑢𝑡))

2
+ (20 𝑙𝑜𝑔( 1 − 𝛤𝑠𝑜𝑢𝑟𝑐𝑒𝛤𝐷𝑈𝑇_𝑖𝑛𝑝𝑢𝑡))

2

+(20 𝑙𝑜𝑔( 1 − 𝛤𝐷𝑈𝑇 _ 𝑜𝑢𝑡𝑝𝑢𝑡𝛤𝑆𝐴 _ 𝑖𝑛𝑝𝑢𝑡))
2

+ (𝑆𝐴𝑔𝑎𝑖𝑛 _ 𝑢𝑛𝑐𝑒𝑟𝑡𝑎𝑖𝑛𝑡𝑦 _ 𝑑𝐵)
2

(20) 
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7.4 Uncertainty in the ENR of the Noise Source 

The fourth term is the uncertainty of the noise source ENR values supplied by the manufacturer. This 

uncertainty is typically specified by the noise source supplier, and is generally in the area of 0.1 dB to 0.2 dB. 

 

𝛥𝐸𝑁𝑅𝑑𝐵 ≅ 0.2 (21) 

7.5 NF Measurement Uncertainty Example 

Assume the following reflection coefficients: 

noise source 0.05 (26 dB return loss) 

DUT input 0.251 (12 dB return loss) 

DUT output 0.316 (10 dB return loss) 

SA input  0.2  (14 dB return loss) 

 

Assume SA NF is measured as 12 dB. (noise factor of 15.85) 

Assume the DUT gain is 15 dB   (gain of 31.62) 

Assume NF of DUT and SA cascade is 7.85 dB 

    therefore DUT noise figure is calculated as 7.5 dB 

(noise factor of 6.095)  

(noise factor of 5.62) 

Assume SA noise figure uncertainty is 0.05 dB  

Assume SA gain uncertainty is 0.059 dB  

Assume the ENR uncertainty is 0.2 dB.  

 

Using equation 18: 

( ) ( )

dB

F dBSADUT

1245.0

05.01097.0
22

_&

=

+=

 

 

And from equation 19: 

( ) ( )

dB

F dBSA

1053.0
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22

_
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Equation 20: 

( ) ( ) ( ) ( )

dB

G dBDUT

587.0

059.0567.00873.01097.0
2222

_

=
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And Equation 21: 

𝛥𝐸𝑁𝑅𝑑𝐵 = 0.2  

 

The required linear ratios are: 

 

𝐹𝐷𝑈𝑇&𝑆𝐴

𝐹𝐷𝑈𝑇

=
6.095

5.62
= 1.085 

𝐹𝑆𝐴

𝐹𝐷𝑈𝑇𝐺𝐷𝑈𝑇

=
15.85

(5.62)(31.62)
= 0.0892 

𝐹𝑆𝐴 − 1

𝐹𝐷𝑈𝑇𝐺𝐷𝑈𝑇

=
15.85 − 1

(5.62)(31.62)
= 0.0836 

𝐹𝐷𝑈𝑇&𝑆𝐴

𝐹𝐷𝑈𝑇

−
𝐹𝑆𝐴

𝐹𝐷𝑈𝑇𝐺𝐷𝑈𝑇

=
6.095

5.62
−

15.85

(5.62)(31.62)
= 0.996 

Substitution of the values into equation 17 results in an overall Noise Figure Uncertainty of: 

                       

( ) ( ) ( ) ( )
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8 The Rohde & Schwarz Noise Figure and 

Uncertainty Calculator  

While the measurement guidelines presented in Section 5 are fairly straightforward to evaluate, the noise 

figure measurement uncertainty is very tedious to calculate manually. To make this task easier, Rohde & 

Schwarz provides a Noise Figure and Uncertainty Calculator along with this application note (free-of-charge 

from the R&S website). This calculator is intended for use on a Microsoft Windows 7 or Windows XP 

operating system. It is a stand alone executable program and does not utilize an installer. The application 

consists of a single window that calculates noise figure measurement uncertainty and evaluates the 

measurement guidelines. The user simply enters the pertinent parameters for the noise source, DUT, and 

analyzer. There is also the option to calculate noise figure and gain from the manual measurements 

described in Section 4. 

8.1 Basic Usage of the Calculator 

The main function of the calculator is to estimate noise figure measurement uncertainty and to evaluate the 

measurement guidelines. The measurement uncertainty is based on the following user-entered parameters: 

► Noise Source Output Match (VSWR or Return Loss) 

► Noise Source ENR Uncertainty (dB) 

► DUT Input and Output Match (VSWR or Return Loss) 

► DUT Noise Figure and Gain (dB) 

► Spectrum Analyzer Input Match (VSWR or Return Loss) 

► Spectrum Analyzer Noise (Noise Figure or DANL) 

► Spectrum Analyzer Gain Uncertainty and Noise Figure Uncertainties (dB) 

 

The measurement guidelines are based on these user-entered parameters: 

► Noise Source ENR (dB) 

► DUT Noise Figure and Gain (dB) 

► Spectrum Analyzer Noise (Noise Figure or DANL) 

 

The noise figure measurement uncertainty and measurement guidelines are updated immediately when any 

parameter is changed. 

The user may enter the noise source parameters manually (User) or choose a specific model from the noise 

source drop down list (see Figure 9). When a model is chosen its specified output match and nominal ENR 

will be automatically entered. The match is frequency dependent so it will change with the entered frequency.  

The ENR value is device specific so only the nominal ENR for the selected model is set. 

Similarly, the spectrum analyzer values may be entered manually (User) or a spectrum analyzer model may 

be chosen from the drop down list. When a spectrum analyzer model is chosen the specified input match, 

DANL, gain uncertainty and noise figure uncertainty are set. If the selected model has an internal preamp 

option the “Int PA” checkbox will be enabled and, when checked, the proper DANL will be set accordingly. 

The input match and DANL values are frequency dependent so they will change with the entered frequency.  

In addition to the internal preamp selection, the user may evaluate the effect of an external preamp by 
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selecting the Ext PA checkbox. When selected the user can enter the gain and noise figure of the external 

preamp. Also, the Analyzer Input Match field becomes Ext PA Input Match. 

When a noise source or spectrum analyzer model is selected the values set are guaranteed, not typical.  

Actual performance will likely be better than these worst-case values. 

The uncertainty calculation is slightly different when measuring a frequency converting device.  The utility has 

a check box to indicate this type of DUT. When the “Freq Conv” box is checked there will be two frequency 

fields for input and output frequencies. Note that if the noise source and spectrum analyzer are both set to 

“User” the Frequency field is irrelevant and will not be used in any calculations. 

When analyzer noise is entered as DANL the utility converts it to equivalent noise figure for the uncertainty 

calculation using the formula:  NF = DANL + 173.98dBm + 2.51dB – 0.27dB (173.98dBm is kTB at 290K, 

2.51dB is the correction for sample detection and log averaging used for DANL specs, and 0.27dB is the 

equivalent noise bandwidth correction for the 1kHz digital Gaussian RBW filter used for DANL specs). 

Two additional, but usually small contributors to measurement uncertainty are the spectrum analyzer gain 

and noise figure uncertainties.  If a specific model spectrum analyzer is selected these values are entered 

automatically.  The user can hide these values by selecting Option→Hide SA Uncertainties from the menu, 

but they are still used in the uncertainty calculation. 

Noise figure measurements of high-gain devices are sometimes done without calibration since the noise 

added by the second stage (analyzer) is insignificant.  The user has the option to view the effects of omitting 

second stage correction by de-selecting “Enable 2nd Stage Correction” from the Option menu.  This will 

eliminate the calibration step from the uncertainty calculation and show the measurement offset error (always 

positive) due to the uncorrected second stage.  Note that when second stage correction is disabled the 

measurement guidelines are not displayed. 

 

 

 

 

 

 

 

 

 

 

 

8.2 Showing Estimated Manually Measured Levels 

The utility has the additional capability of showing estimated levels of the four underlying measurements 

described in Section 4.  These values are estimated from the Noise Source ENR, DUT Noise Figure and 

Gain, and Analyzer Noise.  Select “Show Manual Measurement Values” from the Options menu to view these 

values (see Figure 10).  Note that the four absolute levels are only estimates since the absolute levels are 

dependent on spectrum analyzer resolution bandwidth, filter shape factor, losses, etc.  However, the deltas 

between the levels and correspondingly, Ycal, Ymeas, NFsa, NF(dut+sa) are accurate. 

Figure 9: Rohde & Schwarz Noise Figure and Uncertainty Calculator. NS346B Noise Source and FSW26 Spectrum Analyzer with 

Internal Preamp are selected. 
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Figure 10: Noise Figure and Uncertainty Calculator with estimated measurement values enabled. 

8.3 Fully Manual Noise Figure Measurement 

The utility can also perform the calculations described in Section 4 to implement a fully manual noise figure 

measurement.  The calibration and measurement fields will be enabled for user entry if the check box labeled 

“Enable manual entry of measurement values” is checked (see Figure 11).   

The parameters used to calculate the DUT noise figure, gain and analyzer noise are: 

► ENR value (dB)  

► Ambient Temperature of the Noise Source (degrees C) 

► Noise floor measurement of Analyzer with noise source “off”  (dBm) 

► Noise floor measurement of Analyzer with noise source “on”  (dBm) 

► Noise measurement of DUT output with noise source “off”  (dBm) 

► Noise measurement of DUT output with noise source “on”  (dBm) 

DUT noise figure and gain are updated as these values are entered as well as noise figure measurement 

uncertainty and measurement guidelines. In addition, the noise figure of the spectrum analyzer is displayed 

in the bottom of the “Calibration” section and the cascaded noise figure of the DUT and the analyzer is 

displayed in the bottom of the “Measurement” section. 

ENR values provided by the manufacturer or calibration lab are referenced to an ambient temperature of 

290˚K. Often, however, the actual ambient temperature during a measurement is not 290˚K. The “Ambient 

Temp” field provides a means to enter the actual ambient temperature of the noise source so the noise figure 

is correctly calculated using the effective ENR and Ton values (displayed in noise source area). Referring 

back to Figure 4, the change in ambient temperature can be visualized by horizontally shifting the vertical 

Toff and Ton points together, while the slope and y-intercept of the measured blue line remain unchanged. 
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Figure 11: Calculator with manual measurement entry enabled showing example from Section 4. 

8.4 Using Measurement Guidelines to Ensure a Repeatable Result 

The measurement guidelines presented in Section 5 are evaluated based on DUT noise figure and gain, and 

analyzer noise figure, and ENR. These guidelines give an indication of the quality of the measurement. The 

compliance to each of the guidelines is indicated as follows: 

Green light: Guideline condition met 

Yellow light: Guideline condition not met, but within 1dB of being met 

Red light: Guideline condition not met 

 

The goal for the user is to choose a noise source, spectrum analyzer, and preamp so that all three 

Measurement Guidelines are marked with a green light. Note that the noise source ENR will affect guidelines 

1 and 2 and the spectrum analyzer/preamp (internal or external) combination will affect guidelines 1 and 3. It 

may appear that higher ENR is always better, however noise sources with higher ENR also have worse 

VSWR which can degrade uncertainty so it’s best to choose a noise source with the lowest ENR necessary 

to satisfy the guidelines. For the spectrum analyzer, lower noise figure is always better. Figure 12 shows an 

example where guidelines 1 and 3 are not being met. This is an indication that the noise figure of the 

analyzer is not low enough to make a quality measurement and a preamp (internal or external) should be 

considered. 
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Figure 12: Example Demonstrating the use of the Measurement Guidelines. 

8.5 Overview of Menus and Additional Features 

In addition to calculating uncertainty and measurement guidelines, the utility makes it easy to evaluate the 

sensitivity of the noise figure measurement uncertainty to each of the various contributors.  Any parameter 

may be incremented by highlighting the parameter and pressing the Cntl-Up Arrow (+0.01dB), Up Arrow 

(+0.1dB), or Shift-Up Arrow (+1dB) keys.  The down arrow key is similarly used to decrement the highlighted 

parameter.  By shifting individual parameters by 0.1dB and monitoring the uncertainty value the user may 

quickly evaluate the sensitivity of measurement uncertainty to each parameter.  This provides a simple 

method for quickly determining which parameters have the most significant effect on the measurement 

uncertainty and where improvements might be made. 

The uncertainty result display has a default resolution of 0.01dB, but the user can choose resolutions from 

0.1dB to 0.0001dB by clicking anywhere in the NF Measurement Uncertainty area and selecting the desired 

resolution.  Select UI Hints in the Help menu to show all keyboard shortcuts (see Figure 13). 

 

Figure 13: UI Hints are available under the Help Menu. 

 

Measurement Guidelines 
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Most user entered parameters are protected against invalid entries (e.g. VSWR < 1, ENR < 0, etc.), however, 

error conditions can arise if certain combinations of values are entered. If an error does occur the utility will 

indicate in red what the problem is and which parameter should be addressed (see Figure 14). 

The situations that can cause such an error are: 

► DUT Noise Figure < -DUT Gain  (i.e. NF<Loss) 

► NS On Level < NS Off Level (Calibration or Measurement) 

► Measurement NS Off Level < Calibration NS Off Level 

 

The File menu has three selections. “Reset to Startup Values” resets the program to the original values 

without changing any optional settings. “Preset” resets all aspects of the utility to startup conditions. “Exit” 

closes the application.  

 

Figure 14: Example showing error condition (Calibration NS Off level > NS On level). 

 

The Web menu contains a list of links for R&S Noise Figure option pages, Noise Source product pages, and 

related Application Notes.  

 

Figure 15: The Web Menu contains links to some useful web sites related to noise figure measurements.  
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9 Ways to Improve Noise Figure Results 

There are several possible remedies if the calculated uncertainty does not meet the requirements of the 

application. Usually, the largest contributor to measurement uncertainty is the noise figure of the spectrum 

analyzer. Without a preamp, typical spectrum analyzers have over 20dB noise figure. Fortunately, most 

spectrum analyzers offer an optional internal preamp that significantly improves the analyzer noise figure.  In 

fact, a preamp (internal or external) is almost always required for good noise figure measurements.   

For example, if a DUT has 5dB noise figure and 10dB gain, a mid-range spectrum analyzer without a preamp 

can result in a noise figure measurement uncertainty of more than 6dB! The internal preamp improves this to 

0.7dB.  An external preamp with high gain and low noise figure will yield even further improvement.  The 

preamp (internal, external, or both) is treated as part of the measurement system and is calibrated out of the 

measurement along with the rest of the second stage contributions. 

Mismatches also contribute to the uncertainty. Small attenuators or isolators may be added to minimize 

mismatch and improve the uncertainty. These components must be included during the calibration step so 

they will be accounted for in the measurement. Also, noise sources with lower ENR values generally have 

better match performance. 

In addition to minimizing measurement uncertainty, we want to maximize measurement repeatability. We do 

this by ensuring that the measurement setup satisfies the three measurement guidelines presented in 

Section 5. Using a spectrum analyzer and preamp to get a low resulting measurement system noise figure is 

always desirable. However, choosing an optimum noise source takes a little more investigation since higher 

ENR noise sources have worse match characteristics.  Good match improves uncertainty, but high ENR 

improves repeatability. 
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10 Conclusion 

It is fairly straightforward to make noise figure measurements with a noise source and a spectrum analyzer.  

The manual process may be tedious, but can yield accurate results. Guidelines are provided to ensure a 

repeatable measurement with a known uncertainty. Rohde & Schwarz offers a software utility that calculates 

the noise figure and the uncertainty based on the measurement conditions. The uncertainty calculator allows 

many measurement scenarios to be quickly evaluated for accuracy. 

In addition to the manual process, most modern spectrum analyzers (and all current Rohde & Schwarz 

spectrum analyzers) offer a noise figure personality. The noise figure personality automates all the steps of 

the measurement, providing the user with the noise figure and gain of the DUT in graphical and tabular form. 

 

  

Figure 16: The Rohde & Schwarz FSW spectrum analyzer. This is an ideal instrument for making Noise Figure measurements due to 

its low noise figure, available built-in pre-amplifier and noise source control. 
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12 Ordering Information 

Designation Type Order No. 

Signal and spectrum analyzer R&S®FSW 1331.5003.xx  
 

Signal and spectrum analyzer R&S®FSV3000 1330.5000.xx 

Signal and spectrum analyzer R&S®FSVA3000 1330.5000.xx 

Real-time spectrum analyzer R&S®FSVR 1311.0006.xx 

Phase noise analyzer and VCO tester R&S®FSWP 1322.8003.xx 

Spectrum analyzer R&S®FSL18 1300.2505.xx 
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Application Note | The Y Factor Technique for Noise Figure 

Measurements 
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